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1. INTRODUCTION 

1.1. Overview 

THERM is a Microsoft Windows™-based computer program developed at Lawrence Berkeley National 
Laboratory (LBNL) for use by building component manufacturers, engineers, educators, students, architects, 
and others interested in two-dimensional heat transfer.  Using THERM, you can model two-dimensional 
heat-transfer effects in building components such as windows, walls, foundations, roofs, and doors, 
appliances, and other products where thermal bridges are of concern.  THERM's heat-transfer analysis allows 
you to evaluate a product’s energy efficiency and local temperature patterns, which may relate directly to 
problems with condensation, moisture damage, and structural integrity.   

THERM’s two-dimensional conduction heat-transfer analysis is based on the finite-element method, which 
can model the complicated geometries of building products.  The program’s graphic interface allows you to 
draw cross sections of products or components to be analyzed.  To create the cross sections, you can trace 
imported files in DXF or bitmap format, or input the geometry from known dimensions. Each cross section is 
represented by a combination of polygons.  The material properties are defined for each polygon and the 
environmental conditions to which the component is exposed are defined by the boundary conditions 
surrounding the cross section.  Once the model is created, the remaining analysis (mesher and heat transfer) 
is automatic.  You can view results from THERM in several forms, including U-factors, isotherms, heat-flux 
vectors, and local temperatures. 

THERM's results can be used to define the frame elements in the Berkeley Lab WINDOW program’s center-
of-glass optical and thermal models to determine total window product U-factors and Solar Heat Gain 
Coefficients.  

Program downloads, update information, and Knowledge Base articles about THERM and the other software 
tools from the Windows and Daylighting Group at LBNL can be found at: windows.lbl.gov. If you have 
questions or problems about using the program, email ThermHelp@lbl.gov or go to the THERM Forum 
(Google Group) at https://groups.google.com/forum/#!forum/lbnl-therm where you can post and reply to 
questions about the program.  

1.2. THERM 8 Transient Moisture Model 

The THERM simulation engine been extended to model time dependent (transient) simulations (a “time 

domain” has been added to THERM’s original 2-D Finite Element Numerical Model (FEM)), and a moisture 
transfer model has been added.  

The transient thermal and moisture simulation engine in THERM (called HygroThermFEM) allows modeling 
of thermal bridges and non-homogeneities in building construction without approximation. Such elements 
are primary pathways and causes for condensation and moisture in building and it is important to model 
them correctly in a thermal/moisture analysis. By failing to account for the moisture characteristics in the 
thermal envelope, designers and building can introduce problems that endanger the health and safety of 
building occupants as well as the durability of the building itself. 

The HygroTHERMFEM model in THERM8 will allow building simulation practitioners to accurately model 
wall, roof, foundation constructions taking into account both the thermal and moisture characteristics of those 
constructions. 

 

windows.lbl.gov
mailto:ThermHelp@lbl.gov
https://groups.google.com/forum/#!forum/lbnl-therm
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1.3. Changes from THERM 7 to THERM 8 

The following are the changes made to THERM 8 to accommodate the new moisture model: 

 Simulation engine options (File / Properties) 

 Steady-state without moisture (THERM 7) 

 Transient/moisture  

 Material and Boundary Condition Libraries 

 The Material and Boundary Condition Libraries for the transient / moisture model are stored in 

the XML file format and have a new grid view 

 Visualization “window” for viewing the moisture results 

This document is not a complete THERM user manual, but instead contains the changes made to THERM 8 
for the Transient Moisture Model. 
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2. Transient Moisture and Thermal Simulations 

2.1. Overview 

THERM allows modeling both transient moisture and thermal simualtions, as well as stead-state thermal 
simulations.  

The sections below describe the settings for transient moisture and thermal simulations. 

2.2.  File / Properties 

The File / Properties dialog box controls what model is used for a given file. All the settings in the three tabs 
of the File / Properties dialog box are saved with individual files, not as program-level settings.  
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Calculation Options tab 

Below is a description of the fields in the File / Properties / Calculation Options tab. 

 

Figure 2-1. File/Properties contains settings for both the steady-state and transient models. 

 

Heat Transfer Check this box to model heat transfer. 

Checking this box is appropriate for 

 Simulation engine = Steady-State Thermal (ConRad) 

 Simulation engine = Transient Therm + Moisture (HygroThermFEM)  

 

Moisture Check this box to model moisture.  



2. Transient Moisture and Thermal Simulations 2.2.  File / Properties 

THERM 8 User Manual November 7, 2020 2-3 

Checking this box is appropriate for 

 Simulation engine = Transient Therm + Moisture (HygroThermFEM) 

 

Transient 

Initial 
Conditions 

Initial simulation conditions will be based on either: 

 User values from text file (warm up section): currently not implemented  

 Use first time step in text file: currently not implemented 

 User defined – Constant values everywhere 

 Temperature: Default: 21 C. 

 Relative Humidity: Default: 50. Units: percentage (%) 

 

Steady State (for HygroThermFEM engine) 
Currently not implemented in THERM 8 

No Time 
Variable 

This uses the same steady state equation to calculation heat transfer as ConRad, and 
there is no time variable. See technical documentation  

False transient 
(using state 
BCs) 

This runs a transient simulation until it reaches a steady state solution.  

Initial Conditions: this sets the temperature and relative humidity of the entire model 
to start the simulation.  

It is also necessary to have transient-style Boundary Conditions (ie, XML file) that 
have contant temperature and relative humidity values over the timesteps.  

Modeling Options 
For the HygorThermFEM simulation engine 

 These are modeling options to set when modeling moisture using the 
HygroThermFEM engine: 

 Water Liquid Transportation: Models transport of water in a liquid state. If 

this is not checked, then only water vapor is modeled.  

 Heat of Evaporation: Models phase change of water. 

 Capilary Conduction: Models capillary transport through  

 Vapor Diffusion Conduction: Models diffusion of vapor thorugh material.  

 Temperature and Moisture Dependency on Thermal Conductivity: Currently 

not available 

 Latent Heat of Fusion: Currently not available 

 

Default: All options are selected by default. 

Simulation Engine 

Steady-State 
Thermal 
(ConRad) 

Steady-state thermal simulation 
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Transient 
Therm + 
Moisture 
(HygroTherm
FEM) 

Transient thermal and moisture simulation engine 

Simulation Engine Parameters 

Convergence 
Tolerance 

This controls the simulation error norm tolerance. If the error norm calculation is 
greater than this value, the program will display an “non-convergence” error 
message. If using the transient moisture model and it doesn’t converge, this value 
could be reduced to 1e-02.  

Used in both the ConRad and HygroThermFEM simulation engines. 

Default: 1e-05.  

Relaxation 
Parameter 

This is the initial value for relaxation parameter used in iterations.  

Used in both the ConRad and HygroThermFEM simulation engines. 

Default: 1. 

Time Step This parameter is used by the HygroThermFEM transient model to set the length of 
the time step. The default value of 3600 seconds equals 1 hour. Default: 3600. Units: 
seconds. 

Number of 
Time Steps 

This parameter determines how many times steps are calculated when the 
HygroThermFEM engine is selected. It works in conjunction with the Time Step 
value. The default Time Step value of 3600 seconds (1 hour) used with the default 
value of the Number of Time Steps (8670) would result in a simulation at 1 hour 
intervals for a year. Default: 8670. Units: unitless 

Mesh Control 
For both the HygorThermFEM and ConRad simulation engines 

Quad Tree 
Mesh 
Parameter 

The relative size of the finite element mesh created for the model. The larger the 
number the finer the mesh. The upper limit of the mesh parameter is usually 9. 
Increasing this value may help mesh files that return “mesh errors”. Default: 6. 

Run Error 
Estimator 

If this option is checked, the program will perform the calculation of the error energy 
norm. If the simulation does not meet the value in Maximum % Error Energy Norm, 
the program will increment the Quadtree Mesh Parameter (if Automatically 
increment mesh parameter is checked on the Simulation tab), until the Maximum 
Iteration value is reached. 

Default: checked. 

Maximum % 
Error Energy 
Norm 

THERM incorporates a local error estimator and subsequent local mesh 
refinement. The error estimator is based on a published and well regarded 
methodology based on the estimate of Error Energy Norm (EEN). In this technique, 
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only regions with an EEN larger than the threshold value are refined, resulting in 
optimum mesh size. An EEN value of 10% is chosen for the default because it results 
in overall computational accuracy of well below 1%, which is the ISO 10211 
requirement. 

Default: 10% 

Maximum 
Iterations 

The number of iterations for the program to run in an attempt to meet the Maximum 
% Error Energy Norm specified.  

Default: 5 

Miscellanceous Parameters 
For the ConRad simulation engine 

Radiance 
Mode 

If this option is checked, THERM will use Radiance to model the optical properties of 
a THERM model. This is used for modeling shading systems whose geometry is 
modeled in THERM. The THERM background will turn gray when this option is 
checked, to indicate that this option is selected, because this is not an option that 
would normally be used.  

Default: unchecked. 

Use CR for 
Glazing 
Systems 

If this option is checked, THERM will perform a Condensation Resistance simulation 
as well as the standard U-factor calculation. 

This option only applies to the ConRad Simulation Engine. 

Default: unchecked. 

Check for 
Correct 
WINDOW BC 
on Glazing 
Systems 

If this option is checked, THERM will check to see that the Boundary Conditions 
applied to an imported WINDOW glazing system match those that were imported 
with that glazing system.  

Default: unchecked. 

Modeling Options 

Automatically 
adjust 
relaxation 
parameter 

When equations are not converging, the relaxation parameter modifies previous 
iteration result in order to better converge. The values are from 0 to 1. The solver 
starts from a value of 1 and reduces it from there. 

For ConRad simulation engine. 

Default: checked 

Adjustment 
step 

Incremental reduction of the relaxation parameter from 1 to 0.  

For ConRad simulation engine. 

Default: -0.01 
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Maximum 
iterations 

Number of iterations to apply the automatic relaxation parameter adjustment to. 

For both the HygorThermFEM and ConRad simulation engines 

Default: 25 

View Factor 
Smoothing 

This is used for gray body radiation calculation. If the view factors (surfaces being 
viewed) are very different, such as blocking surfaces, the view factor smoothing 
helps accuracy of results. See TARCOG technical documentation on the THERM 
documentation webpage. 

For ConRad simulation engine. 
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Typical settings for a transient thermal and moisture simulation (HygroThermFEM) 

  

 

Figure 2-2.  Typical File/Properties settings for a transient thermal and moisture model. 
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Typical settings for a steady-state thermal calculation (ConRad) 

 

Figure 2-3.  Typical File/Properties settings for a steady-state thermal model. 
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Model Exposure tab 

Below is a description of the fields in the File / Properties / Model Exposure tab. 

 

Figure 2-4.  File Properties / Model Exposure tab. 

 

Model Purpose This pulldown list consists of the following options 

 Window / Transparent Façade 

 Opaque Façade 

 Other 

 

Assembly 
Type 

If Model Purpose is set to Opaque Façade, this pulldown list becomes active with 
the following choices: 

 Wall 

 Roof 

If Model Purpose is set to either Window/Transparent Façade or Other, this value is 
set to “N/A”. 

Model 
Orientation 

The direction the exterior surface of the model faces. This orientation of the exterior 
surface is used to determine the wind direction for the simulation.  

Below are the standard Cardinal orientations, but any value from 0 – 360 may be 
entered. 

 North = 0 

 East = 90 

 South = 180 

 West = 270 

Legal values: 0 – 360.  

Units: degrees 

Cross Section 
Type 

The values in this pulldown depend on the Model Purpose selection. 

 If Model Purpose = Window / Transparent Façade, the choices are 
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Figure 2-5.  Cross-Section Type if Model Purpose = Window/Transparent Facade. 

Note: this setting was located under the Therm File Properties tab in previous 
versions of the program.  

 If Model Purpose = Opaque Façade, the choices are 

 

Figure 2-6.  Cross-Section Type if Model Purpose = Opaque Facade. 

 If Model Purpose = Other, the choices are 

 

Figure 2-7.  Cross-Section Type if Model Purpose = Other. 

Gravity Vector The choices for the gravity vector are 

 

Figure 2-8.  Gravity Vector options. 

Note: Setting the gravity vector was done from the View menu in previous versions 
of THERM 

Note: This setting will change the View/Gravity Arrow to match. Don’t change 
gravity vector from the View menu in this version of THERM. 
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2.3.  Material Library 

The Material Library is different depending on the Simulation Engine selected. 

 ConRad: If the ConRad simulation engine is selected, the Material library is the same as in previous 

versions of THERM. 

 HygroThermFEM: If the HygroThermFEM simulation engine is selected, the Material library is much 

different. 

2.3.1. Material Library List View 

Selecting the Material choice from the Libraries menu when the HygroThermFEM simulation model is 

selected displays the Materials in “List View”. 

 

Figure 2-9.  Material List View. 

Buttons 

The buttons on the left hand side of the List View have the following functions: 

 

Detailed 
View 

Used to access the detailed view of the record, where the input values can be edited. 

New Used to make a new record, based on a default record. Click the New button, and the program 
will create a new record at the bottom of the list called “Default Name”. Highlight that record 
and click the Detailed View button to edit the new record as needed. 

Copy Used to copy an existing record (including name and all associated input values) into a new 
record. Highlight the record to be copied and click the Copy button. The new record will be 
added to the bottom of the list. Highlight that record and click the Detailed View button to edit 
the new record as needed. 

Delete Used to delete a record. Highlight the record to delete and click the Delete button. 



2.3.  Material Library 2. Transient Moisture and Thermal Simulations 

2-12 November 7, 2020 THERM 8 User Manual 

Import Currently disabled. 

Export Currently disabled. 

Report Currently disabled. 

Print Currently disabled. 

Save 
Lib As 

Currently disabled. 

Load 
Lib 

Currently disabled. 

Column Headings 

The List view contains columns with selected results (from the Detail view) for each record, as described 
below. 

 

Name The name of the material. 

Type The material type, from the options of 

 Solid 

 Frame Cavity 

 Glazing Cavity 

 External Radiation Enclosure 

 Shading Material 

k Conductivity of the material. 

Units: Btu/h-ft-F (IP); W/m-K (SI) 

ρ Density of the material. 

Units: lb/ft3 (IP); kg/m3 (SI) 

Cp Specific heat of the material.  

Units: Btu/lb-F (IP);J/kg-K (SI) 

µ Water Vapor Diffusion Resistance Factor.  

Units: unitless 

Φ Porosity of the material.  

Units: unitless 
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2.3.1. Material Library Detail View 

In the List View, highlight a record and click the Detailed View button to see the detailed input values for 
each material. 

 

Figure 2-10.  Material Detail View. 

Buttons 

The buttons on the right hand side of the Detail View have the following functions: 

 

List 
View 

Used to access the List view of the Material Library. 

Save Saves any changes made to the Materials XML file. 

Cancel Cancels any changes and returns to the List View. 

New Used to make a new record. 

Copy Used to copy an existing record (including name and all associated input values) into a new 
record. Highlight the record to be copied and click the Copy button. The new record will be 
added to the bottom of the list. Highlight that record and click the Detailed View button to edit 
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the new record as needed. 

Edit Currently not implemented. 

Color The color assigned to the material. It can be changed by clicking on the arrow to the right of the 
color box, selecting another color, and then clicking Save to save the changes to the record.  

Figure 2-11.  Color Settings in the Material Library Detail View. 

  

Input Values 

The List view contains columns with selected results (from the Detail view) for each record, as described 
below. 

 

Name The name of the material. 

Material Type 

 The material type, from the options of 

 Solid 

 Frame Cavity 

 Glazing Cavity (currently not implemented for HygroThermFEM) 

 External Radiation Enclosure (currently not implemented for HygroThermFEM) 

 Shading Material (currently not implemented for HygroThermFEM) 

Solid Properties 
These input values are for Material Type = Solid 

Conductivity Conductivity of the material. 

Units: Btu/h-ft-F (IP); W/m-K (SI). 

Emissivity Emissivity of the material. 

Units: unitless 

Porosity Porosity of the material. 

Units: unitless 

Specific Heat 
Capacity 

Specific Heat Capacity of the material. 

Units: Btu/lb-F (IP); J/kg-K (SI). 

Density Density of the material. 
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Units: lb/ft3 (IP); kg/m3 (SI). 

Cavity Properties 
These input values are for Material Type = Frame Cavity 

Radiation 
Model 

The Frame Cavity Radition Model, from the following choices: 

 CEN 

 ISO 15099 

Convection 
Cavity 
Model 

Currently not implemented for HygroThermFEM. 

Radiation 
Cavity 
Model 

Currently not implemented for HygroThermFEM. 

Gas Fill The gas fill in the cavity, from the following choices: 

 Air 

 Argon 

 Krypton 

 Xenon 

Emissivites 
Side 1 

Currently not implemented for HygroThermFEM. 

Emissivities 
Side 2 

Currently not implemented for HygroThermFEM. 

Liquid Transportation Redistribution 

  

Figure 2-12.  Liquid Transportation Redistribution variables for Stucco material. 

Water 
Content 

Water content. 

Units: lb/ft3 (IP); kg/m3 (SI). 

Dl Liquid transportation coefficient. 

Units: ft2/s (IP); m2/s (SI). 

Import File To import data into this function, create a CSV file with the two values separated by a 
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Format comma. The values (always in SI units) are: 

 Water Content 

 Dl (liquid transportation coefficient) 

 

Figure 2-13.  Import CSV file format for Liquid Transportation Redistribution variables, always in SI 
units. 

Liquid Transportation Suction 

 

Figure 2-14.  Liquid Transportation Suction variables for 3-ply cross-laminated panel material. 

Water 
Content 

Water content. 

Units: lb/ft3 (IP); kg/m3 (SI). 

Dl Liquid transportation coefficient. 

Units: ft2/s (IP); m2/s (SI). 

Import File 
Format 

To import data into this function, create a CSV file with the two values separated by a 
comma. The values (always in SI units) are: 

 Water Content (kg/m3) 

 Dl (liquid transportation coefficient, m2/s) 

 

Figure 2-15.  Import CSV file format for Liquid Transportation Suction variables for 3-ply cross-
laminated panel material, always in SI units. 

 
Moisture Dependent Thermal Conductivity 
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Figure 2-16.  Moisture Dependent Thermal Conductivity variables for Laminated Panel material. 

Water 
Content 

Water content. 

Units: lb/ft3 (IP); kg/m3 (SI). 

Thermal 
Conductivity 

Thermal conductivity.  

Units: Btu/h-ft-F (IP); W/m-K (SI). 

Import File 
Format 

To import data into this function, create a CSV file with the two values separated by a 
comma. The values (always in SI units) are: 

 Water Content (kg/m3) 

 Thermal Conductivity (W/m-K) 

 

Figure 2-17.  Import CSV file format for Moisture Dependent Thermal Conductivity variables for 
Lamianted Panel material, always in SI units. 

Moisture Storage Function 

                          

Figure 2-18.  Moisture Storage Function variables for Laminated Panel material. 
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Humidity Humidity fraction.  

Legal values: 0 – 1. 

Units: unitless. 

Water 
content 

Water content. 

Units: lb/ft3 (IP); kg/m3 (SI). 

Import File 
Format 

To import data into this function, create a CSV file with the two values separated by a 
comma. The values (always in SI units) are: 

 Humidity (fraction, 0-1) 

 Water Content (kg/m3) 

 

Figure 2-19.  Import CSV file format for Moisture Storage Function variables for Lamianted Panel 
material, always in SI units. 

Temperature Dependent Thermal Conductivity 

 

Figure 2-20.  Temperature Dependent Thermal Conductivity variables for Laminated Panel material. 

Temperature Temperature. 

Units: F (IP); C (IP). 

Thermal 
Conductivity 

Thermal conductivity.  

Units: Btu/h-ft-F (IP); W/m-K (SI). 
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Import File 
Format 

To import data into this function, create a CSV file with the two values separated by a 
comma. The values (always in SI units) are: 

 Temperature (C) 

 Thermal Conductivity (W/m-K) 

 

Figure 2-21.  Import CSV file format for Temperature Dependent Thermal Conductivity variables for 
Lamianted Panel material, always in SI units. 

  

File Format and Location 

The Material Library is stored in an XML file called “Materials.xml” which is located in the “lib” subfolder of 
the THERM working directory. 

C:\Users\Public\LBNL\THERM8.0\lib 

  

Figure 2-22.  The Materials.xml file is located in the “lib” subfolder of the THERM working directory. 

The definitions of all the materials displayed in the THERM Material Library are stored in this XML file. 

 
Figure 2-23.  The Materials.xml file contains all the values for all the material records in the Material Library. 
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Making New Material Library Records 

Using either the New or the Copy buttons in either the List or Detail View, it is possible to create new records. 
In the Detail View, the new or copied record value can be changes, and then those changes saved by clicking 
the Save button. Those changes are then made in the Material.xml file.  

For example, if a new “solid” material record is created, and values added for the Solid Properties section as 
well as the different functions on the right side, all those changes are then saved in the Materials.xml file. 

Figure 2-24.  Make a new material using either New or Copy and change the input values as needed. 

Create a new 
Material using 
either New or 
Copy 

Edit the values 
as needed 

Import the data 
into each function 
as needed 

Save the 
changes when 
complete 

The changes are 
saved in the 
Materials.xml 
file 
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2.4.  Boundary Condition Library 

The Boundary Condition Library is different depending on the Simulation Engine selected. 

 ConRad: If the ConRad simulation engine is selected, the Material library is the same as in previous 

versions of THERM. 

 HygroThermFEM: If the HygroThermFEM simulation engine is selected, the Material library is much 

different. 

2.4.1. Boundary Condition Library List View 

Selecting the Boundary Condition choice from the Libraries menu when the HygroThermFEM simulation 

model is selected displays the Boundary Condition records in “List View”. 

 

Figure 2-25.  Boundary Condition List View. 

Buttons 

The buttons on the left hand side of the List View have the following functions: 

 

Detailed 
View 

Used to access the detailed view of the record, where the input values can be edited. 

New Used to make a new record, based on a default record. Click the New button, and the program 
will create a new record at the bottom of the list called “Default Name”. Highlight that record 
and click the Detailed View button to edit the new record as needed. 

Copy Used to copy an existing record (including name and all associated input values) into a new 
record. Highlight the record to be copied and click the Copy button. The new record will be 
added to the bottom of the list. Highlight that record and click the Detailed View button to edit 
the new record as needed. 

Delete Used to delete a record. Highlight the record to delete and click the Delete button. 

Import Currently disabled. 

Export Currently disabled. 
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Report Currently disabled. 

Print Currently disabled. 

Save 
Lib As 

Currently disabled. 

Load 
Lib 

Currently disabled. 

Column Headings  

The List view contains columns with selected results (from the Detail view) for each record, as described 
below. 

 

Name The name of the boundary condition. 

Type The boundary condition type, from the options of 

 Transient 

 Steady State (this is for the case where the transient moisture model is used 

with steady state algorithms, not currently implemented) 

Convection 
Model 

Options are: 

 ASHRAE/NFRC Outside 

 ASHRAE/NFRC Inside 

 Fixed Convection Coefficient 

 TARP 

 Yazdanian Klems 

 Kimura 

 Montazeri  

Temperature For Type = Steady State, Convection Model Air Temperature.  

Steady State is not currently implemented for HygroThermFEM.  

Units: F (IP); C (SI) 

Film 
Coefficient 

For Type = Steady State, Convection Model Film Coefficient.  

Steady State is not currently implemented for HygroThermFEM.  

Units: Btu/h-ft2-F (IP); W/m2-K (SI) 

Heat Flux For Type = Steady State, Convection Model Heat Flux.  

Steady State is not currently implemented for HygroThermFEM.  

Units: Btu/h-ft2 (IP); W/m2 (SI) 
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Solar 
Radiation 

For Type = Steady State, Convection Model Solar Radiation.  

Steady State is not currently implemented for HygroThermFEM.  

Units: Btu/h-ft2 (IP); W/m2 (SI) 

Radiation 
Model 

For the Neumann Boundary Condition Type, if the Radiation Checkbox is checked, the 
Radiation model will be one of the following: 

 Automatic Enclosure Model 

 Black Body Radiation 

 Fixed Radiation Coefficient 

Film 
Coefficient 

For Type = Steady State, Radiation Model Film Coefficient.  

Steady State is not currently implemented for HygroThermFEM.  

Units: Btu/h-ft2-F (IP); W/m2-K (SI) 

Temperature For Type = Steady State, Radiation Model Radiation Surface Temperature.  

Steady State is not currently implemented for HygroThermFEM.  

Units: F (IP); C (SI) 

Humidity For Type = Steady State, Radiation Model Humidity fraction.  

Steady State is not currently implemented for HygroThermFEM.  

Legal Values: 0-1 

Units: unitless 
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2.4.1. Boundary Condition Library Detail View 

In the List View, highlight a record and click the Detailed View button to see the detailed input values for 
each boundary condition. 

 

Figure 2-26.  Boundary Condition Detail View. 

Buttons 

The buttons on the right hand side of the Detail View have the following functions: 

 

List 
View 

Used to access the List view of the Boundary Condition Library. 

Save Saves any changes made to the BoundaryConditions XML file. If changes are made to a field, 
move off the field in order for the Save button to become activated. 

Cancel Cancels any changes and returns to the List View. 

New Used to make a new record. 

Copy Used to copy an existing record (including name and all associated input values) into a new 
record. Highlight the record to be copied and click the Copy button. The new record will be 
added to the bottom of the list. Highlight that record and click the Detailed View button to edit 
the new record as needed. 

Edit Currently not implemented. 
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Color The color assigned to the boundary condition. It can be changed by clicking on the arrow to the 
right of the color box, selecting another color, and then clicking Save to save the changes to the 
record.  

Figure 2-27.  Color Settings in the Boundary Conditions Library Detail View. 

One convention is to make the interior (warm) boundary conditions in the “red” colorway, and 
the exterior (cold) boundary conditions in the “blue” colorway. 

  

Input Values 

The List view contains columns with selected results (from the Detail view) for each record, as described 
below.  

 

Name The name of the boundary condition. 

Transient This is selected by default, and not editable in this version. The non-transient 
boundary conditions would be for the Steady State mode for the HygroThermFEM 
simulation engine, which has not been implemented yet.  

Neumann Boundary Condition Type 

Convection This option is checked if the boundary condition will include convection modeling. 

Model The Model pulldown list pertains to the type of convection model to be used, from the 
following choices: 

 ASHRAE/NFRC Outside 

 ASHRAE/NFRC Inside 

 Fixed Convection Coefficient 

 TARP 

 Yazdanian Klems 

 Kimura 

 Montazeri  

 For the Montazeri Convection Model, extra input values will be entered 

when assigning those to a specific boundary condition segment, which are 

 Building Width 

 Building Height 
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Figure 2-28.  Building Width and Building Height are entered for specific boundary condition segments 
when they are assigned the Boundary Condition Type = Montezeri. 

 

Radiation This option is checked if the boundary condition will include Radiation modeling 

The Radiation model options are: 

 Automatic Enclosure Model 

 Black Body Radiation 

 Fixed Radiation Coefficient 

Heat Flux This option is checked if the boundary condition will include Heat Flux modeling 

Solar 
Radiation 

This option is checked if the boundary condition will include Solar Radiation 
modeling 

Dirichelt Boundary Condition Type 

Temperature Check this option to include Temperature in this Boundary Condition Type 

Humidity Check this option to include Humidity in this Boundary Condition Type 
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File Format and Location 

The Boundary Condition Library is stored in an XML file called “BoundaryConditions.xml” which is located 
in the “lib” subfolder of the THERM working directory. 

C:\Users\Public\LBNL\THERM8.0\lib 

  

Figure 2-29.  The BoundaryConditions.xml file is located in the “lib” subfolder of the THERM working directory. 

The definitions of all the boundary conditions displayed in the THERM Boundary Condition Library are 
stored in this XML file. 

 

Figure 2-30.  The BoundaryConditions.xml file contains all the values for all the material records in the Material Library. 
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Making New Boundary Condition Library Records 

Using either the New or the Copy buttons in either the List or Detail View, it is possible to create new records. 
In the Detail View, the new or copied record value can be changes, and then those changes saved by clicking 
the Save button. Those changes are then made in the BoundaryCondition.xml file.  

For example, if a new boundary condition record is created, all the settings for that boundary condition are 
saved in the BoundaryConditions.xml file. 

Figure 2-31.  Make a new boundary condition using either New or Copy and change the input values as needed.  
The changes will be saved into the BoundaryConditions.xml file. 

 

 

Create a new 
Material using 
either New or 
Copy 

Edit the values 
as needed 

Save the 
changes when 
complete 

The changes are saved in 
the BoundaryConditions.xml 
file 
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Time Step Boundary Condition Files 

In addition to specifying a standard Boundary Condition for a boundary condition segment when using the 
transient simulation engine (HygroThermFEM), it is also necessary to specify a Time Step Boundary 
Condition, which are stored in separate XML files.  

There are several examples of Time Step files that are installed with THERM 8, and they are found in the “lib” 
subfolder of the THERM working directory. 

C:\Users\Public\LBNL\THERM8.0\lib 

  

Figure 2-32.  The Boundary Condition Time Step files are located in the “lib” subfolder of the THERM working directory. 

These example files have a common naming convention of “BC_TS_” to indicate that they are Boundary 
Condition Time Step files, but the files can have any name desired.  

The Time Step files contain values for as many time steps as are being defined in each.  
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For example, the example file “BS_TS_FixedFilmInterior.xml” file has 5 timestep sections, with definitions for 
Temperature, Humidity and Film Coefficient for each time step.  

Figure 2-33.  The Boundary Condition Time Step file format. 

TimeStep 
section 

In each TimeStep section, 
there are values for 

 Temperature 

 Humidity 

 FilmCoefficient 
  

There are 5 time steps 
in this file, each with a 
different value for 
Temperature, Humidity 
and Film Coefficient 
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Applying Boundary Conditions to a Model 

Applying boundary conditions to a model is similar to how they are applied in previous versions of THERM, 
with a few exceptions.  

 

 After the model is completed, click the BC toolbar button to assign the boundary conditions. Intially, 

all the boundary conditions for the model will be set to “Adiabatic”.  

 

Figure 2-34.  Click the BC toolbar icon to generate the intial boundary conditions for the model, 
which will initially all be set to Adiabatic (with a black color0. 
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 Select the desired boundary condition segments to assign boundary conditions to and either double 

click the left mouse button or press the Enter key, in order to open the Boundary Condition selection 

dialog box. 

 Select the Boundary Condition from the pulldown list which displays the records from the Boundary 

Condition Library 

 Select the U-factor Surface tag as applicable 

 Select the Timestep Input Filename as applicable. The OK button will not be activated until a 

Timestep Input Filename has been specified 

Figure 2-35.  Specify both a Boundary Condition and a Timestep File for each boundary segment in a model. 

  

Double click on a 
boundary condition 
segment to open the 
Boundary Condition 
dialog box 

Select the Timestep file to use for 
this boundary condition segment 

Select the 
Boundary 
Condition from 
the Library 



2. Transient Moisture and Thermal Simulations 2.5.  Simulate the Model 

THERM 8 User Manual November 7, 2020 2-33 

2.5.  Simulate the Model 

When the model has been drawn, and materials and boundary conditions assigned, the model can be 
simulated by clicking the Calc toolbar icon, or selecting the Calculation/Calculation (F9) menu option. 

In the example file below (from the sample file called “Stucco Wall – Moisture.thm”), the File/Properties 
Time Step is set to 3600 seconds (1 hour), the Number of Time Steps is set to 100, and the QuadTree Mesh 
Parameter is set to 4. 

 

Figure 2-36.  File/Properties setting for the sample file called “Stucco Wall – Moisture.thm”. 

The sample file Stucco Wall – Moisture.thm consists of five polygons. 

Figure 2-37.  Stucco Wall – Moisture.thm. 

Gypsum Board 
Interior 

Fiberglass Batt 

Laminated 
Panel 

Stucco 
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The boundary condition definitions are shown below. The Timestep Input files have a timestep of 120, and 
the File/Properties Time Step value is set to 100, so the lower of the two timestep settings will determine the 
time step for the simulation, in this case 100 timesteps. 

 Figure 2-38.  Boundary Condition definitions. 

Interior Boundary 
Conditions, 
including a 
Timestep file with 
120 timesteps 
defined 

Exterior Boundary 
Conditions, 
including a Timestep 
file with 120 
timesteps defined 
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During the transient simulation, the program will display a small progress window showing the current 
timestep.  

 

Figure 2-39.  A progress window shows the status of the transient simulation. 
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2.6.  View the Results 

When the simulation has finished, the progress window will close.  

To view the results, click the Calculation / Show Results menu option to open the THERM Visualization 
program. It may take a few seconds to appear. 

This results visualization tool shows a color flooded image on the left and a graph of the results on the right. 

 

 

Figure 2-40.  The THERM Visualization tool. 
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The slider at the top of the visualization tool allows results to be viewed at each timestep. There are also three 
different values that can be displayed, chosen from the Data pulldown list: 

 Temperatures 

 Humidities 

 Water Content 

The slider on the left side allows placement of the horiztonal location line, which determines the values 
displayed in the graph on the right hand side. This is useful when viewing results for a non-symmetrical 
model. 

 

Figure 2-41.  The THERM Visualization tool control options 

 . 

Move the slider to see the 
results at each timestep 

Select data to display from the choices of:  

 Temperatures 

 Humidities 

 Water Content 
 

The position of this 
slider determines 
the location in the 
model of the 
graphed values 
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Figure 2-42.  Temperatures over the timesteps 

Temperature, Timestep 20 

Temperature, Timestep 80 

Temperature, Timestep 100 
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Figure 2-43.  Humidities over the timesteps 

Humidities, Timestep 0 

Humidities, Timestep 60 

Humidities, Timestep 100 




